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1 Web License 
Overview, Set Up 
and Management

The information in this guide is arranged into the following 
main topics:

• Kurzweil 3000 Web License Overview on page 2.

• Web License System Requirements on page 5.

• Installing Web License Client Software on page 6.

• Working with User Accounts and License Allocation on page 7.

• Registering Users on page 8.

• Viewing and Managing Licenses on page 16.

• Viewing and Changing Your Personal User Information and 
Password on page 18.

• For Top Level Coordinators on page 20.
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Kurzweil 3000 Web License Overview
Kurzweil 3000 Web License Overview
Licenses for Using Kurzweil 3000 Over the Internet

The Kurzweil 3000 Web License product offers convenient, secure Kurzweil 
3000 license check in/out through the Web.

Unlike Network Edition licenses, the storage and management of which are 
on the local network, Web licenses are stored and managed by Cambium 
Learning and delivered to users over the Internet. 

In addition to placing less of a burden on a school’s technology team, Web 
Licensing allows users to access licenses and run Kurzweil 3000 from any 
computer on which the Kurzweil 3000 Web License Client software is 
installed, and from anywhere on the Internet.

Web License Users

There are three types of users:

• Designated License Coordinator who is set up by Cambium Learning for 
the organization. This user has the ability to create and manage sub-
users and to allot licenses to those sub-users, which can include Student 
users. When viewing user information, this user can see and change all 
of his/her sub-users’ information. When viewing Universal Library 
contents, this user can access all of his/her sub-users’ folders. 

• Site coordinator who could be a teacher, principal, or other school 
authority. Set up by the organization’s license coordinator, this user has 
the ability to create and manage sub-users, including Student users, and 
to allot licenses to those sub-users. When viewing user information, the 
site coordinator/teacher user can see and change all of his/her sub-
users’ information. When viewing Universal Library contents, this user 
can access all of his/her sub-users’ folders. 

• Student users are created and registered by any user who can create 
sub-users. They cannot, however, have sub-users, nor have access 
other users’ folders in the Universal Library except Public ones created 
by their teachers or for the organization. 
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Kurzweil 3000 Web License Overview 
Complemented by Web-Based Universal Library

Included with the Kurzweil 3000 Web License Edition is the Web Universal 
Library, a robust file repository that provides leveled access to files and 
documents.

The Web Universal Library enables districts or schools to widely distribute 
curriculum, and share and reuse material. Any user can upload district-wide 
curriculum and resource files. Teachers are able to post classwork, and 
students can access those files and documents from anywhere on the 
Internet, from any Kurzweil 3000 Web Client computer, at any time.

The Web License Universal Library also includes the Classic Literature 
collection of nearly 2000 public domain electronic text, from literary classics, 
factbooks, and references to religious and historical documents.

Roaming Preferences

Once set, Kurzweil 3000 personal preferences, such as reading voice and 
reading speed, are maintained allowing you to work on Macintosh to 
Macintosh without having to reset options. (Kurzweil 3000 Macintosh 
settings are not valid in Kurzweil 3000 Windows systems and vice versa.)
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Kurzweil 3000 Web License Overview
How Does Web License Work? 

Once your organization completes the Web License product purchase 
process, an IT specialist installs the Web License Client Software, and an 
initial user account is set up by Cambium Learning Customer Service for a 
designated License Coordinator. 

That initial user, who could be a school administrator, IT specialist, even a 
teacher, then creates sub-user accounts for sub-site coordinators at different 
schools, teachers and/or students. At the time of user setup, the system 
generates login information — a username and password — for each user. 

Each user, other than Student users, can set up and manage sub-users 
under his/her account.

To access Kurzweil 3000, log in using the Kurzweil 3000 desktop icon on a 
computer running Web License Client software.
4



Web License System Requirements 
Web License System Requirements
Minimum G3 processor, running Mac OS X 10.4 (Tiger) to 10.6 (Snow 
Leopard).

Minimum 128 MB RAM (512MB RAM for Cepstral voices).

Minimum 300 MB of hard disk space (500 MB for Cepstral voices).

DVD drive, keyboard, mouse, speakers, microphone, Internet connection for 
Read the Web functionality.

TWAIN- or Image Capture-compatible scanner.

Internet connection required for product use.
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Installing Web License Client Software
Installing Web License Client Software
To install Web License client software:

1. Place the Kurzweil 3000 DVD into the DVD drive.

2. From the DVD window, drag the Kurzweil 3000 application icon to your 
Applications folder.

3. Start Kurzweil 3000 by double-clicking the Kurzweil 3000 icon.

You are ready to log in to and use Web License Edition by clicking the 
Kurzweil 3000 icon.
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Working with User Accounts and License Allocation 
Working with User Accounts and License 
Allocation

After your organization purchases a number of Web Licenses, Cambium 
Learning Customer Service sets up the initial user (typically, this is a 
designated site coordinator who could be teacher, school administrator or IT 
specialist). He/she is given username and password for login.

The site coordinator/initial user can then set up the site users, providing them 
with their system-generated usernames and passwords, and allocating 
licenses.

Once that is done, any user can log in, set up, manage and distribute 
licenses to sub-users under their accounts.

Sub-users are typically teachers who set up their own sub-users, typically 
students.

Student users, however, do not have User Management access.

Accessing the User Management System:

Go to https://www.fireflybykurzweil.com/ and log in.

Note: From Kurzweil 3000, you can access your firefly account by choosing 
My Account from the Kurzweil 3000 menu. If you need frequent access to this 
link, consider using View > Customize Toolbars to place the My Account 
button on a toolbar.
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Working with User Accounts and License Allocation
The Home page opens. Click the My Account tab to display site account 
information such as the number of licenses purchased, allocated and 
activated.

Along the top, right-hand area are three tabs: Home, My Account, and Help. 
Log Out is in the upper-right-hand corner of the firefly window.

Registering Users

There are three ways to register sub-users under your account:

• You can use Kurzweil’s free user import and rostering service.

• You can register each user yourself using the Add Users feature.

• You can initiate self-registration and send a link to the users you want to 
self-register.

Using User Import and Rostering Service
If you purchased a site or district license, we offer a free user import and 
rostering service. It is recommended that we create your user accounts 
through this import process, instead of manually creating user accounts (a 
8



Working with User Accounts and License Allocation 
process that is explained in this document). To take advantage of the free 
import and rostering service, please email fireflyroster@cambiumtech.com.

Using the Add Users Feature
1. Log in. Your Home page opens (or, if you were logged on previously and 

then logged out from a different page, the Profile page for example, that 
page will open).

2. Hover the cursor over the My Account tab to display the menu. 

3. Select Users from the drop-down menu Your Team page will open.
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Working with User Accounts and License Allocation
4. Click the Everyone icon and when it opens, click the Add User tab. .

5. Add the user information: First Name, Last Name, Password, Email, 
School/Org, and External Id. The Student box is pre-checked. If you are 
adding a teacher, uncheck the Student box. The External ID can be any 
identifier that you want – a Student ID Number, for example. This field is 
only used as a search field. Note: if you specify a password, the 
password must be at least 5 characters with no apostrophes. All other 
fields are required. If the user has a valid email address the login 
information is automatically emailed to the user. If the user does not have 
an email address, enter the TLC’s email address as a placeholder. You 
will then need to provide the user the login information. 
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Working with User Accounts and License Allocation 
Note: If you have more than one user to enter, use the drop-down list to 
select a number of fields to add, and click Add More. The number you 
select will add that many more lines of fields. 

6. When you have finished adding users, click Save. 

The user information then appears in the Student or Teacher list on the 
Everyone page, along with the system-generated username and 
password (if you didn’t already provide one). 

Note that these usernames and passwords can also be used to login to 
the Kurzweil 3000 Web License Product and the free firefly iPad 
application that can be downloaded from https://www.kurzweiledu.com/
kurzweil-3000-firefly-ipad-app.html. 

Initiate User Self-Registration
Links to the self-registration form enable teachers and students to add 
themselves to the firefly roster. Only the top-level coordinator can initiate self-
registration. 
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Working with User Accounts and License Allocation
1. Hover the cursor over the My Account tab to display the menu.

2. Select Users from the drop-down menu. Your My Team page opens.

3. Click Self-Registration. A window opens that displays a link for you to 
copy and send to teachers and a link for you to copy and send to 
12



Working with User Accounts and License Allocation 
students. Note: Because teachers and students have different privileges, 
it’s important to send the correct link. 

4. Click the Copy button next to the appropriate link (Teacher self-
registration or Student self-registration).

5. Open your email application and address an email to the teachers or 
students you want to self-register. 

6. In the message section of the email, paste the link you copied from the 
self-registration window.

7. Send.

The recipient will click the link in the email they’ve received and the User Self-
Registration form will display.
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Working with User Accounts and License Allocation
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Working with User Accounts and License Allocation 
After filling in the information and clicking the Add New button, a “Success” 
message will display that includes the username, password, and a link to the 
login form.
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Working with User Accounts and License Allocation
Viewing and Managing Licenses

To view license information:

1. Hover the cursor over the My Account tab and choose Users from the 
drop-down menu. Open any of the Everyone pages (Student, Teachers, 
or Add Users) or your Team page. 

2. At the top of the page you can find:

• Total Licenses: the total number of licenses for your site.

• Allocated Licenses: the number of licenses distributed among users.

• Remaining Licenses: the number of licenses remaining; that is the Total 
Licenses minus the Allocated Licenses.
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Working with User Accounts and License Allocation 
Managing Users

To Update User Information:

1. Hover the cursor over the My Account tab and choose Users from the 
drop-down menu. Click your Team icon. 

2. Locate the user to be updated. Note that lists can be sorted alphabetically 
in ascending or descending order by selecting the down or up arrows at 
the top of each column. You can also use any of the search fields at the 
top of the list. t.

3. All the text fields can be edited. Place your cursor in a field that needs 
updating and start typing. The line of fields is outlined in yellow and you’ll 
notice that the Save button is activated. Note: To change the password, 
click the Show link beneath the Password column heading. 

4. Click Save when you have finished making changes. Note that these 
changes will appear on the Everyone list and on any Team page the user 
information appears. 
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Working with User Accounts and License Allocation
To Remove a User from Your Team: 

Only a TLC can delete a user, but you can remove a user from your Team 
page. The user will still exist on the Everyone list. 

1. Hover the cursor over the My Account tab and choose Users from the 
drop-down menu. 

2. Click your Team or the Everyone icon. 

3. Find the user that you want to remove from your Team and click the 

Remove button to the right of the user information if you are on your 
Team page or uncheck the checkbox to the right of the user information 
if you are on the Everyone page. Either of these actions will remove the 
user from your Team page. 

Viewing and Changing Your Personal User Information and 
Password

To view and change your own user information, including password:

1. Hover the mouse over My Account to display the menu, then click 
Profile.
18



Working with User Accounts and License Allocation 
The Manage Profile page includes user information such as address 
and occupation, login, and school/organization information.

2. Make the desired changes.

3. Then click Update Account Information.

Forgot Password?

1. Click the Forgot Password in the log in page.

2. In the Forgot Password? page, enter the email address associated with 
your account.

3. Your username and the original password will be emailed to you.

4. Use the emailed password to log in.

5. Go to and follow the instructions in To view and change your own user 
information above.
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Working with User Accounts and License Allocation
For Top Level Coordinators

Only a Top Level Coordinator (TLC) can delete a user. Later, if needed, the 
TLC can restore that user. Notice that the TLC Coordinator has an additional 
icon: Restore Users. 

To Delete a User 

1. Log in as TLC. 

2. Open the Everyone Page. In the right column you will notice a trash can 
icon next to each user in the list.

3. Click the Delete button next to each user that you want to delete. 
20



Working with User Accounts and License Allocation 
To Restore Users 

There are times when the TLC may need to restore a user that was deleted. 
To Restore a User: 

1. Click the Restore Users button. A list of Users who were previously 
removed is displayed. 

2. Click the Restore button in the right column next to each user that you 
want to restore. 

3. The user(s) will be restored to the Everyone list.
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Working with User Accounts and License Allocation
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2 Web Universal 
Library 

This chapter contains four main sections.

• The Web Universal Library Overview on page 24 has the following 
subsections:

Web Universal Library Structure on page 24.

• Using the Web Universal Library on page 26 has the following 
subsections:

To open a document from the Library: on page 26.

To save an open document to the Library: on page 27.

To create a new folder in the Universal Library: on page 27.

To rename a file or folder in the Universal Library: on page 27.

To delete a file or directory in the Universal Library: on page 28.

To cut or copy, and paste a file or folder in the Universal Library on 
page 28.
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The Web Universal Library Overview
The Web Universal Library Overview
Kurzweil 3000 Web License Edition includes the Web Universal Library. If 
your school uses the Kurzweil 3000 Local Area Network (LAN) Universal 
Library, you are already aware of the benefits of central file storage and 
sharing.

The Kurzweil 3000 Web Universal Library, however, is an expanded version 
of the LAN Universal Library. Because the Web Universal Library is Internet-
based, it allows students and teachers, or any authorized users, using any 
computer running Web License Client software from anywhere on the World 
Wide Web, to access and share files.

For districts and schools, the Web Universal Library is ideal for placing 
standardized curriculum material and print resources in electronic form for all 
or for specific groups to access. Teachers can make class files available 
wherever, whenever students need them.

Included in each Web Universal Library are the following folders: 

• Classic Literature, a collection of nearly 2000 books, historical 
documents selected from the public domain

• Samples, files from Cambium Learning Group's published educational 
series, LANGUAGE!, Learning A-Z and Passport Reading Journeys.

Web Universal Library Structure

The structure of the Universal Library is based on user/sub-user file system 
concept where each authorized user can set up and manage his/her sub-
users.

In addition to sub-user folders, each user also has a Public folder and a 
Private folder. All users have Read-Write permission to his/her own and to 
sub-users’ Public and Private folders

Sub-users only have Read access to the Public folder of the user who 
created their account.

For example, a district could set up folders for each school. In a school's 
folder, there could be folders for teachers as well as a Public and a Private 
24



Chapter 2. Web Universal Library
folder. All teachers and students in the school could access the school’s 
Public folder. Teachers would not be able to access one another’s folders. 

Each teacher folder in turn would have the teacher’s students' folders, plus a 
Public and Private folder. All students whose accounts a teacher creates 
would be able to access their teacher’s Public folder. Students would not be 
able to access one another’s folders.
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Using the Web Universal Library
Using the Web Universal Library
You can open and save to the Universal Library and manage folders and files 
by using either the Open from the Universal Library or Save to the Universal 
Library.

The Web Universal Library currently supports RTF, TXT and KES file 
formats.

To open a document from the Library:

1. From the File menu, choose Open from Library to open the Universal 
Library.

2. Navigate to the desired folder and file, then click Open.

3. Use the Kurzweil 3000 Reader to read the file.
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Chapter 2. Web Universal Library
To save an open document to the Library:

1. Open the document you want to save to the library.

2. From the File menu, choose Save to Universal Library.

3. In the dialog, specify where you want to place the file by clicking the 
desired folder in the left-hand pane.

4. Click Save.

Notes: 

• When saving a file, you are uploading it to the Web server, and the time 
and speed by which a file is uploaded depend on the Internet line and 
service at your site. We recommend 50 pages or fewer per file, so it's a 
good idea to separate chapters and save a chapter at a time.

• You can only save to the directories for which you have access 
privileges.

• No user can save files to the Classic Literature folder.

To create a new folder in the Universal Library:

You can create a new folder in the following places:

• Under your own user directory, in the Private and Public folders.

• In the Public folders of directories belonging to sub-users whose 
accounts you created.

1. From the File menu, choose Save to Universal Library.

2. In the dialog, in the left-hand pane, select the directory under which you 
want to create the new folder.

3. Click the New Folder button.

4. Rename the folder.

To rename a file or folder in the Universal Library:

1. Select the file or folder.

2. Click again or press Return to begin editing.

3. Type the new name, then press Return.
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Using the Web Universal Library
To delete a file or directory in the Universal Library:

1. From the File menu, choose either Open from or Save to Universal 
Library.

2. In the dialog, do one of the following: 

In the left-hand pane, select the directory you want to delete.

In the right-hand pane, select the file you want to delete.

3. Do one of the following:

Control-click and in the context menu, choose Delete.

Use the Forward-Delete or Backward-Delete shortcuts.

Notes: 

• If you use the Delete command in the Save to Universal Library dialog, 
you have to click Save to close the dialog when you are done.

• You can only delete from the directories for which you have access 
privileges.

• No user can delete files from the Classic Literature folder.

To cut or copy, and paste a file or folder in the Universal Library

1. From the File menu, choose Open from Universal Library.

2. In the dialog, do the following: 

In the left-hand pane, navigate to and select the folder you want to cut or 
copy, or the folder that contains the file you want to cut or copy. You can 
only cut or copy folders that are inside your public or private folder. 

In the right-hand pane, select the file you want to cut or copy.

3. Control-click to show the context menu, choose Cut or Copy.

4. Do one of the following:

To paste a file into another folder in the Universal Library, navigate to the 
desired folder in the left-hand pane, click in the right-hand pane, control-
click to show the context menu, and then choose Paste.
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Chapter 2. Web Universal Library
To paste a folder into another folder in the Universal Library, navigate to 
the desired folder in the left-hand pane, control-click to show the context 
menu, and then choose Paste.

To paste a file or folder elsewhere on your desktop or system, navigate 
to that location, control-click to show the context menu, and then choose 
Paste.

Notes: 

• Note that you can only paste if you have Copy To privileges.

• It is possible to Copy-Paste files and folders from the Universal Library to 
the Finder, and files (not folders) from the Finder to the Universal Library.

• No user can cut files from or paste files into the Classic Literature folder.
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